Quantification of Extracellular Double-stranded RNA Uptake and Subcellular Localization Using Flow Cytometry and Confocal Microscopy
Tan A Nguyen1, 2, Lachlan Whitehead1, 2 and Ken C Pang1, 3, 4, 5, *

1The Walter and Eliza Hall Institute of Medical Research, Parkville, VIC, Australia; 2Department of Medical Biology, University of Melbourne, Parkville, VIC, Australia; 3Murdoch Children's Research Institute, Parkville, VIC, Australia; 4Department of Paediatrics, University of Melbourne, Parkville, VIC, Australia; 5Department of Psychiatry, University of Melbourne, Parkville, VIC, Australia
*For correspondence: ken.pang@mcri.edu.au

[Abstract] Double-stranded RNA is a potent pathogen-associated molecular pattern (PAMP) produced as a by-product of viral replication and a well-known hallmark of viral infection. Viral dsRNAs can be released from infected cells into the extracellular space and internalized by neighboring cells via endocytosis. Mammals possess multiple pattern recognition receptors (PRRs) capable of detecting viral dsRNAs such as endosomal toll-like receptor 3 (TLR3) and cytosolic RIG-I-like receptors (RLRs) which lead to the production of type I interferons (IFNs). Thus, intracellular localization of viral dsRNA can provide insight into the downstream signaling pathways leading to innate immune activation. Here, we describe a quantitative method for measuring extracellular dsRNA uptake and visualizing subcellular localization of internalized dsRNA via flow cytometry and confocal microscopy respectively.

Keywords: Double-stranded RNA, Endosomes, Lysosomes, Viruses, Poly(I:C), TLR3, RIG-I, MDA-5, Confocal microscopy, Flow cytometry

[Background] Double-stranded RNAs (dsRNAs) are a common by-product of viral replication and are potent activators of antiviral immunity via the production of type I interferon (IFN) and other pro-inflammatory cytokines (Nellimarla and Mossman, 2014). Viral dsRNAs are sensed within endosomes by TLR3 (Matsumoto et al., 2003) or in the cytosol by the RIG-I-like receptors (RLRs), RIG-I and MDA-5 (Kato et al., 2006). During lytic infections, these dsRNAs can be released into the extracellular space where they bind surface receptors on neighboring cells, such as class A scavenger receptors (SR-A) and Raftlin, and are subsequently internalized via clathrin-mediated endocytosis (Itoh et al., 2008; DeWitte-Orr et al., 2010; Watanabe et al., 2011; Dansako et al., 2013).

In our previous study, we found out that the protein SID1 transmembrane family member 2 (SIDT2) localizes to late endosomes and lysosomes and that loss of SIDT2 leads to subcellular accumulation of the synthetic dsRNA analog, poly(I:C), while not affecting initial endocytosis-mediated internalization (Nguyen et al., 2017). To do so, we developed and utilized flow cytometry and confocal microscopy-based approaches to quantitatively measure poly(I:C) uptake and subcellular localization respectively in vitro. In this protocol, we describe a further refinement of these assays to allow for high-throughput assessment of internalization and subcellular localization of different dsRNAs. These methods allow for
further dissection of dsRNA trafficking during viral infection and the downstream effects of these dsRNAs on innate immune signaling.

**Materials and Reagents**

1. 8 well microscope slide (ibidi, catalog number: 80826)
2. 24 well tissue culture plate (Corning, Falcon®, catalog number: 353047)
3. Sterile filtered pipette tips (0.5 µl to 1,000 µl) (Corning, Axygen, catalogue numbers: TF-300-L-R-S, TF-20-L-R-S, TF-200-L-R-S and TF-1000-L-R-S)
4. 10 cm culture dishes (Corning, Falcon®, catalog number: 353003)
5. 10 ml centrifuge tubes (SARSTEDT, catalog number: 62.9924.284)
6. 1.5 ml microcentrifuge tubes (Sigma-Aldrich, catalog number: EP0030120086)
7. 1.2 ml Micro Titertube (Thermo Fisher Scientific, Quality Scientific Plastics, catalog number: 845-Q)
8. Serological pipettes, individually wrapped, 10 ml (Corning, Falcon®, catalog number: 356551)
9. Mammalian cell line of interest, here: mouse embryonic fibroblasts (see Note 1)
10. 70% (v/v) ethanol (Chem Supply, catalog number: EA043)
11. Dulbecco’s modified Eagle medium (DMEM) or other suitable complete growth medium for culture of cell line of interest
12. Fetal bovine serum (FBS) (Sigma-Aldrich, catalog number: F9423)
14. Penicillin/streptomycin solution (Sigma-Aldrich, catalog number: P4333)
15. Poly(l:C)-fluorescein (InvivoGen, catalog number: tlrl-picf)
16. Poly(l:C)-rhodamine (InvivoGen, catalog number: tlrl-picr)
17. dsRNA specific monoclonal antibody (J2, SCICONS English and Scientific Consulting, catalog number: 10010200)
18. RNase A enzyme (Sigma-Aldrich, catalog number: R4875)
19. 1x trypsin-EDTA solution (Sigma-Aldrich, catalog number: 59430C)
20. Paraformaldehyde (PFA) powder (Sigma-Aldrich, catalog number: 158127)
21. Tween 20 (Sigma-Aldrich, catalog number: P1379)
22. DAPI (4’6-Diamidine-2’-phenylindole dihydrochloride) powder (Sigma-Aldrich, catalog number: D9542)
23. ImmersolTM Immersion Oil (Carl Zeiss, catalog number: 4449620000000)
24. Complete growth medium (see Recipes)
25. 10% FBS/PBS (see Recipes)
26. 4% paraformaldehyde (w/v) (see Recipes)
27. Permeabilization buffer (see Recipes)
28. DAPI solution (see Recipes)
Equipment

1. Pipetting aid (Thermo Fisher Scientific, catalog number: 9531)
2. Micropipettes from 0.5 µl to 1 ml (Mettler-Toledo International, Rainin, model: Pipet-Lite™ XLS+)
3. Hemocytometer
4. Class II biological safety cabinet/tissue culture hood
5. Humidified CO2 incubator (95% air, 5% CO2, 37 °C)
6. Inverted light microscope (phase contrast)
7. 37 °C water bath
8. Vacuum aspiration system with glass Pasteur pipettes
9. Table top centrifuge equipped with a swing-out rotor for 10 ml conical tubes
10. Microcentrifuge
11. LSRFortessa X20 (BD, BD Biosciences, model: LSRFortessa™ X-20) or equivalent flow cytometer
12. LSM 780 confocal laser scanning microscope (ZEISS, model: LSM 780) or equivalent microscope

Software

1. FIJI/ImageJ
2. Zeiss ZEN package
3. Microsoft Excel
4. FlowJo
5. GraphPad Prism 7

Procedure

A. Cell culture and maintenance

1. Perform all cell culture-based work in a class II biological safety cabinet/tissue culture hood. Ensure work surface and materials are sterilized using 70% (v/v) ethanol.
2. Grow mammalian cells of choice in complete growth medium using 10 cm cell culture dishes or cell culture flasks in a humidified CO2 incubator (95% air, 5% CO2, 37 °C). Here, we use mouse embryonic fibroblasts (MEFs) derived from C57BL/6 mice and MEFs lacking the dsRNA transporter, SIDT2, as our gene of interest (see Note 2).
3. Maintain cells using standard cell culture procedures or as recommended by the supplier. Here, split MEFs approximately every 3-4 days or before cells reach 100% confluency using standard cell culture procedures (see Note 3).
4. One day prior to stimulation, split the cells as above and determine cell number using a hemocytometer or other appropriate methods under a light microscope.
B. Quantification of poly(I:C) uptake by flow cytometry

1. Seed 1 x 10^4 cells in a 24 well plate in triplicate for the following conditions in a total volume of 500 µl of complete growth medium (cells may be seeded for additional conditions as required):
   a. Unstimulated
   b. Stimulated with poly(I:C) (see Note 4)
2. Let cells adhere and rest overnight in a humidified CO₂ incubator (95% air, 5% CO₂, 37 °C).
3. The next morning, remove cells from the incubator and add 1 µg/ml of fluorescein-poly(I:C) to the cell culture medium (see Note 5).
4. Stimulate cells in an incubator at 37 °C, 5% CO₂ for 24 h.
5. After 24 h of stimulation, carefully aspirate complete growth medium from each well with a glass Pasteur pipette using a vacuum aspiration system.
6. Wash cells with 1 ml of cold 1x PBS using a P1000 pipette. Carefully add PBS on the side of the well to avoid dislodging cells.
7. Repeat Step B6 for a total of 3 washes.
8. Harvest cells by adding 500 µl of Trypsin to each well and incubate cells at 37 °C, 5% CO₂ for 5 min.
9. Add 500 µl of complete growth medium to each well.
10. Gently resuspend cells by pipetting up and down 3-5 times.
11. Transfer resuspended cells to new individual 1.5 ml microcentrifuge tubes.
12. Centrifuge cells in a microcentrifuge for 3 min at 500 x g and resuspend the pellet in 500 µl PBS supplemented with 10% FBS.
13. Add 10 µl of RNase A enzyme (5 mg/ml stock) to each well at a final concentration of 100 µg/ml (see Note 6).
14. Incubate cells at 37 °C and 5% CO₂ for 30 min.
15. Centrifuge cells in a microcentrifuge for 3 min at 500 x g.
16. Carefully aspirate RNase A solution from each well.
17. Resuspend cells in 1 ml cold PBS.
18. Repeat Step B15 for a total of 3-5 washes.
19. Resuspend cells in 200 µl of 10% FBS/PBS.
20. Transfer cells to individual 1.2 ml Micro Titertubes and leave on ice.
21. Analyze the incorporated fluorescence of cells of both genotypes and using flow cytometry. Compare the histograms and corresponding mean fluorescence intensities (MFI) between fluorescein-poly(I:C)-stimulated cells and unstimulated cells (Figure 1).
Figure 1. Analysis of poly(I:C)-fluorescein uptake by flow cytometry. The endocytic activity of WT and Sidt2−/− MEFs was assessed by measuring the uptake of fluorescein-conjugated poly(I:C) following 24 h stimulation. A. Representative histograms for the mean fluorescence intensities (MFI) for each genotype are shown. B. Mean percentage of poly(I:C)-fluorescein positive cells. n = 3 technical replicates and errors bars represent ± SEM. Loss of SIDT2 did not affect poly(I:C) uptake.

C. Confocal analysis of poly(I:C) subcellular localization

1. Seed 5 x 10³ cells in an 8 well chamber slide for the following conditions in a total volume of 200 µl of complete growth medium (cells may be seeded for additional conditions as required):
   a. Unstimulated
   b. Stimulated with poly(I:C)
2. The next morning, remove cells from the incubator and add 1 µg/ml of rhodamine-poly(I:C) to the cell culture medium (see Note 5).
3. Incubate cells at 37 °C, 5% CO₂ for 24 h.
4. Carefully aspirate and discard complete growth medium from each well with a P200 pipette.
5. Wash cells with 200 ml of cold 1x PBS using a P1000 pipette.
6. Repeat Step C5 for a total of 3 washes.
7. After washes, add 200 µl PBS supplemented with 10% FBS to each well.
8. Add 10 µl of RNase A enzyme (5 mg/ml stock) to each well at a final concentration of 100 µg/ml (see Note 6).
9. Incubate cells at 37 °C and 5% CO₂ for 30 min.
10. Carefully aspirate RNase A solution from each well.
11. Wash cells with 200 µl cold PBS.
12. Repeat Step C11 for a total of 3 washes.
13. Fix cells with 200 µl of 4% PFA for 10 min on ice.
14. Wash cells with 200 µl cold PBS.
15. Repeat Step C14 for a total of 3 washes.
16. Stain cells with 100 ng/ml DAPI solution in a final volume of 200 µl per well for 10 min at room temperature (see Note 7).
17. Wash cells with 200 µl cold PBS.
18. Repeat Step C17 for a total of 3 washes.
19. After the final wash, add 200 µl of PBS to each well.
20. Slides are now ready for imaging or can be stored at 4 °C for up to 2 weeks.
21. Acquire images using a ZEISS LSM 780 confocal microscope (an equivalent microscope can be used) with a 25x oil immersion objective lens.
22. Acquire Z-stack of 0.25 μm slices from the top to the bottom of the cells (Figure 2A).
23. Save images as .lsm files and separate each condition into individual folders (e.g., WT untreated, WT pIC treated, KO untreated, KO pIC treated).
24. Drag and drop all folders into a single folder (see Note 8).
25. Images are now ready for analysis using FIJI/ImageJ software (see below).

Data analysis

A. Determine appropriate threshold value for images
1. Open an image file that contains cells with representative poly(I:C)-rhodamine or alternative dsRNA signal intensity in FIJI/ImageJ.
2. Acquire maximum projection image (Navigate to toolbar on the top left corner of the screen → Image → Stacks → Z Project → Projection type: Max intensity → Okay).
3. Select channel corresponding to poly(I:C)-rhodamine by adjusting the C slider on the bottom of the maximum projection image window.
4. From the toolbar, select Image → Adjust → Threshold…
5. Set bottom slider to 255.
6. Adjust top slider until threshold (red) is able to distinguish between each individual punctate endosome (Figure 2B). Here, we used a threshold of 60.
7. Note down threshold value.
Figure 2. Analysis of poly(I:C)-rhodamine subcellular localization by confocal microscopy. A. WT and Sidt2\textsuperscript{-/-} MEFs were treated with rhodamine-conjugated poly(I:C) for 24 h and assessed via confocal microscopy. Representative maximum projection images are shown, red = poly(I:C), blue = DAPI. B. Snapshot from FIJI/ImageJ showing selection of threshold value step.

B. Subcellular localization quantification

1. Download FIJI macro file from: [https://bitbucket.org/DrLachie/rna_subcell](https://bitbucket.org/DrLachie/rna_subcell).
2. Open macro file in FIJI/ImageJ.
3. Change ‘GreenThreshold’ to the threshold value determined in the above section (e.g., ‘60’).
4. Click ‘Run’.
5. Open output\folder and check the accuracy of cell segmentation (Figure 3A) and individual cell by cell quantification of the punctate area, intensity and number of puncta determined by macro.
6. Open results.xls file located in top folder using Microsoft Excel.
7. Calculate and Graph results for the average punctate area, intensity and number of puncta in Prism GraphPad or equivalent software (Figure 3B) (see Note 9).
Figure 3. Quantification of poly(I:C)-rhodamine subcellular localization using FIJI/ImageJ macro. A. Representative output image following macro quantification showing segmentation of cells using DAPI to delineate between individual cells. Note that poly(I:C) localizes in the cytoplasm and not in the nucleus. B. Comparison of the average percentage punctate area, average intensity and average number of puncta between WT and Sidt2<sup>−/−</sup> MEFs. Data are plotted as mean ± SEM and at least 5 representative fields of view each containing 5-22 cells were analyzed per condition. **P < 0.01, ***P < 0.001.

Notes

1. Other adherent cell lines of interest can also be used such as bone marrow-derived macrophages, HEK293T and NIH3T3, etc. We have also used non-adherent cells such as DC2.4 and bone marrow-derived dendritic cells by treating suspension cells in 1.5 ml microcentrifuge tubes and subsequently mounting fixed cells onto a microscope slide via a cytospin. However, we find that this method leads to a loss of cell morphology and therefore recommend the use of adherent cells if possible.

2. We have previously reported that the loss of SIDT2 leads to accumulation of dsRNA within endosomes (Nguyen et al., 2017). Here, Sidt2<sup>−/−</sup> MEFs were used to assess endosomal subcellular localization compared to WT MEFs. Cells lacking or overexpressing gene of interest can be used in place of Sidt2<sup>−/−</sup> MEFs as desired.

3. Here, we pre-warm 1x PBS, 1x Trypsin solution and complete growth medium to 37 °C using a water bath. Old medium is removed from the cell culture dish using a Pasteur pipette by vacuum aspiration. Cells are subsequently washed with 10 ml of 1x PBS before the addition of 3 ml (per 10 cm dish) of Trypsin solution and incubate for 3-5 min at 37 °C. Detached cells are resuspended in 10 ml/10 cm dish by pipetting 2-3 times up and down and transfer to a 10 ml centrifuge tube. Cells are pelleted in a tabletop centrifuge at 500 x g, 5 min at RT and resuspended in 10 ml of fresh complete growth medium. For cell maintenance, add 1 ml of cell
suspension to a new 10 cm cell culture dish with 10 ml of complete growth medium and incubate in a humidified CO₂ incubator (95% air, 5% CO₂, 37 °C).

4. Here, rhodamine or fluorescein conjugated poly(I:C) (InvivoGen) was used to stimulate cells as it is commercially available and readily accessible. Alternate fluorescently-tagged ligands can also be used as required. We have also successfully detected viral dsRNA via immunofluorescence staining using a dsRNA specific monoclonal antibody (J2, English and Scientific Consulting).

5. The concentration of poly(I:C) and length of stimulation should be optimized according to cell line of interest. We found that MEFs do not efficiently internalize poly(I:C) and therefore require a 24 h stimulation time. However, bone marrow-derived dendritic cells and macrophages require much shorter stimulation times (1 to 3 h) for sufficient uptake.

6. Treating cells with RNase will degrade any surface-bound dsRNA while retaining internalized dsRNA. Here, we used RNase A which is able to cleave both ssRNA and dsRNA at low salt concentrations. Alternatively, RNase III can be used to specifically cleave dsRNA.

7. It is important to stain cells with DAPI in the presence of detergent to permeabilize the cell membrane and allow DAPI access to nuclear DNA. We use 0.1% Tween to permeabilize cells; however, alternative detergents can be used such as Saponin or Triton-X.

8. The FIJI macro used for image analysis requires two layers of folders in order to proceed with analysis.

9. Here, we demonstrate that loss of SIDT2 results in endosomal accumulation of poly(I:C), consistent with our previous findings (Nguyen et al., 2017). In that study, we also performed transient transfection and immunofluorescence staining of various endosomal markers – EEA-1 (early endosomes), RAB-7 (late endosomes) and LAMP-1 (lysosomes) – in order to precisely determine the subcellular localization of poly(I:C) within Sidt2-/- cells.

Recipes

1. Complete growth medium
   Dulbecco’s modified Eagle medium supplemented with:
   10% fetal bovine serum
   100 U/ml penicillin
   100 µg/ml streptomycin
   Filter sterilize, store at 4 ºC

2. 10% FBS/PBS
   450 ml Sterile Phosphate Buffered Saline
   50 ml fetal bovine serum
   Store at 4 ºC
3. 4% paraformaldehyde (w/v)
   a. Dissolve 4 g of PFA powder in 90 ml PBS and heat to 65 °C while stirring. If PFA does not dissolve, add drops of 1 M NaOH until the solution becomes clear.
   b. Bring to 100 ml with PBS. Cool and filter. Aliquot and store at -20 °C. Thaw aliquots as needed and use immediately.
4. Permeabilization buffer
   10 ml PBS
   10 µl of Tween 20
5. DAPI solution
   a. Dissolve stock solution in sterile dH₂O at a final concentration of 1 mg/ml
   b. Dilute stock solution to a final concentration of 1 µg/ml in permeabilization buffer. Use immediately

Acknowledgments

We thank the members of the Wicks and Masters labs, WEHI for helpful discussions. This protocol was adapted from Nguyen et al. (2017) Immunity 47(3):498-509.e6. DOI: 10.1016/j.immuni.2017.08.007. This work was supported by Australian NHMRC (ID 520574 and 1064591), Royal Australasian College of Physicians, Menzies Foundation, CASS Foundation (SM13-4846 and SM14-5566), and Reid Family Trust. The authors declare no conflict of interest.

References


